


Microsoft®

Access 2016
Comprehensive

Boston Columbus Indianapolis New York San Francisco Hoboken
Amsterdam Cape Town Dubai London Madrid Milan Munich Paris Montréal Toronto

Delhi Mexico City São Paulo Sydney Hong Kong Seoul Singapore Taipei Tokyo

Series Editor Mary Anne Poatsy
Cameron | Williams

Series Created by Dr. Robert T. Grauer

(ex•ploring)
1. Investigating in a systematic way: examining. 2. Searching into 
or ranging over for the purpose of  discovery. 

S E R I E S

A01_GRAU9453_01_SE_FM.indd   1 12/02/16   2:43 PM



Vice President of  Career Skills: Andrew Gilfillan
Senior Editor: Samantha Lewis
Team Lead, Project Management: Laura Burgess
Project Manager: Laura Karahalis
Program Manager: Emily Biberger
Development Editor: Barbara Stover
Editorial Assistant: Michael Campbell
Director of  Product Marketing: Maggie Waples
Director of  Field Marketing: Leigh Ann Sims
Product Marketing Manager: Kaylee Carlson
Field Marketing Managers: Molly Schmidt & Joanna Sabella
Marketing Coordinator: Susan Osterlitz
Senior Operations Specialist: Diane Peirano
Senior Art Director: Diane Ernsberger
Interior and Cover Design: Diane Ernsberger
Cover Photo: Courtesy of  Shutterstock® Images
Associate Director of  Design: Blair Brown
Senior Product Strategy Manager: Eric Hakanson
Product Manager, MyITLab: Zachary Alexander
Media Producer, MyITLab: Jaimie Noy
Digital Project Manager, MyITLab: Becca Lowe
Media Project Manager, Production: John Cassar
Full-Service Project Management: Jenna Vittorioso, Lumina Datamatics, Inc.
Composition: Lumina Datamatics, Inc.
Efficacy Curriculum Manager: Jessica Sieminski

Credits and acknowledgments borrowed from other sources and reproduced, with permission, in this textbook appear on the appropriate page within text. 

Microsoft and/or its respective suppliers make no representations about the suitability of  the information contained in the documents and related graphics 
published as part of  the services for any purpose. All such documents and related graphics are provided “as is” without warranty of  any kind. Microsoft 
and/or its respective suppliers hereby disclaim all warranties and conditions with regard to this information, including all warranties and conditions of  
merchantability, whether express, implied or statutory, fitness for a particular purpose, title and non-infringement. In no event shall Microsoft and/or its 
respective suppliers be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of  use, data or profits, whether 
in an action of  contract, negligence or other tortious action, arising out of  or in connection with the use or performance of  information available from the 
services. 

The documents and related graphics contained herein could include technical inaccuracies or typographical errors. Changes are periodically added to the 
information herein. Microsoft and/or its respective suppliers may make improvements and/or changes in the product(s) and/or the program(s) described 
herein at any time. Partial screen shots may be viewed in full within the software version specified.

Microsoft® and Windows® are registered trademarks of  the Microsoft Corporation in the U.S.A. and other countries. This book is not sponsored or endorsed 
by or affiliated with the Microsoft Corporation. 

Copyright © 2017 by Pearson Education, Inc. All rights reserved. Manufactured in the United States of  America. This publication is protected by 
copyright and permission should be obtained from the publisher prior to any prohibited reproduction, storage in a retrieval system, or transmission in 
any form or by any means, electronic, mechanical, photocopying, recording, or likewise. For information regarding permissions, request forms and the 
appropriate contacts within the Pearson Education Global Rights & Permissions department, please visit www.pearsoned.com/permissions/.

Many of  the designations by manufacturers and sellers to distinguish their products are claimed as trademarks. Where those designations appear in this 
book, and the publisher was aware of  a trademark claim, the designations have been printed in initial caps or all caps.

Library of  Congress Control Number: 2015956946

10 9 8 7 6 5 4 3 2 1

ISBN 10:   0-13-447945-9
ISBN 13: 978-0-13-447945-3

A01_GRAU9453_01_SE_FM.indd   2 12/02/16   2:43 PM

http://www.pearsoned.com/permissions/


Dedications

For my husband, Ted, who unselfishly continues to take on more than his share to support me 
throughout the process; and for my children, Laura, Carolyn, and Teddy, whose encouragement and 
love have been inspiring.

Mary Anne Poatsy

I dedicate this book to my wife Anny, for supporting me through the writing process, to my nieces 
Daniela and Gabriela, who someday will be old enough to think it is cool their names are in a book, 
and to my students, who make a career in teaching fulfilling. May you all go forward, change the 
world and inspire others.

Eric Cameron

I offer thanks to my family and colleagues who have supported me on this journey. I would like to 
dedicate the work I have performed toward this undertaking to my little grandson, Yonason Meir 
(known for now as Mei-Mei), who as his name suggests, is the illumination in my life.

Jerri Williams

To my husband Dan, whose encouragement, patience, and love helped make this endeavor possible. 
Thank you for taking on the many additional tasks at home so that I could focus on writing.

Amy Rutledge

A01_GRAU9453_01_SE_FM.indd   3 12/02/16   2:43 PM



iv About the Authors

About the Authors

Mary Anne Poatsy, Series Editor, Windows 10 Author
Mary Anne is a senior faculty member at Montgomery County Community College, teaching various 
computer application and concepts courses in face-to-face and online environments. She holds 
a B.A. in Psychology and Education from Mount Holyoke College and an M.B.A. in Finance from 
Northwestern University’s Kellogg Graduate School of  Management.

Mary Anne has more than 12 years of  educational experience. She is currently adjunct faculty at 
Gwynedd-Mercy College and Montgomery County Community College. She has also taught at Bucks 
County Community College and Muhlenberg College, as well as conducted personal training. Before 
teaching, she was Vice President at Shearson Lehman in the Municipal Bond Investment Banking 
Department.

Eric Cameron, Access Author
Eric Cameron is a tenured Associate Professor at Passaic County Community College, where he 
has taught in the Computer and Information Sciences department since 2001. He holds an M.S. in 
Computer Science and a B.S. degree in Computer Science with minors in Mathematics and Physics, 
both from Montclair State University. He currently co-chairs the College’s General Education 
committee and served as a member of  the College’s Academic Assessment, College Writing, and 
Educational Technology committees at various points. Eric has also developed degrees in Graphic 
Design and Medical Informatics for the College. Eric previously worked as a software engineer both as 
a full-time employee and contractor, most recently for ITT/Exelis (now part of  Harris Corporation).

This is Eric’s fourth publication for Pearson, after authoring Web 2.0 and Windows 8 books in the 
Your Office series and co-authoring the Exploring Access 2013 text.

Jerri Williams, Access Author
Jerri Williams is a Senior Instructor at Montgomery County Community College in Pennsylvania. 
Jerri also works as an independent corporate trainer, technical editor, and content developer. She is 
interested in travel, cooking, movies, and tending to her colonial farmhouse. Jerri is married, and is 
the mother of  two daughters, Holly (an Accounting graduate and full-time mother to an adorable 
son, Meir) and Gwyneth (a corporate defense attorney). Jerri and Gareth live in the suburbs of  
Philadelphia. They enjoy their home and garden, and spending time with family and good friends.

Amy Rutledge, Common Features Author
Amy Rutledge is a Special Instructor of  Management Information Systems at Oakland University 
in Rochester, Michigan. She coordinates academic programs in Microsoft Office applications and 
introductory management information systems courses for the School of  Business Administration. 
Before joining Oakland University as an instructor, Amy spent several years working for a music 
distribution company and automotive manufacturer in various corporate roles including IT project 
management. She holds a B.S. in Business Administration specializing in Management Information 
Systems, and a B.A. in French Modern Language and Literature. She holds an M.B.A from Oakland 
University. She resides in Michigan with her husband, Dan and daughters Emma and Jane.

A01_GRAU9453_01_SE_FM.indd   4 12/02/16   2:43 PM



 About the Authors v

Dr. Robert T. Grauer, Creator of the Exploring Series
Bob Grauer is an Associate Professor in the Department of  Computer Information Systems at the 
University of  Miami, where he is a multiple winner of  the Outstanding Teaching Award in the 
School of  Business, most recently in 2009. He has written numerous COBOL texts and is the vision 
behind the Exploring Office series, with more than three million books in print. His work has been 
translated into three foreign languages and is used in all aspects of  higher education at both national 
and international levels. Bob Grauer has consulted for several major corporations including IBM 
and American Express. He received his Ph.D. in Operations Research in 1972 from the Polytechnic 
Institute of  Brooklyn.

A01_GRAU9453_01_SE_FM.indd   5 12/02/16   2:43 PM



vi Brief Contents

Brief Contents

 Office  Office 2016 Common Features 2

 Access ChApter 1 Introduction to Access 68
ChApter 2 tables and Queries in relational Databases 138
ChApter 3 Using Queries to Make Decisions 216
ChApter 4 Creating and Using professional Forms and reports 268
ChApter 5 Data Validation and Data Analysis 330
ChApter 6 Action and Specialized Queries 390
ChApter 7 Advanced Forms and reports 444
ChApter 8 Get Connected 496
ChApter 9 Fine-tuning the Database 578
ChApter 10 Using Macros and SQL in Access 632

Access Introductory Capstone exercise (Chs. 1–4) 685
Access Comprehensive Capstone exercise (Chs. 5–10) 689

MICrOSOFt OFFICe 2016 SpeCIALISt ACCeSS 691 
GLOSSAry 697 
InDex 703

Application 
Capstone 
exercises

A01_GRAU9453_01_SE_FM.indd   6 12/02/16   4:13 PM



 Contents vii

Contents

Microsoft Office 2016
■ CHAPTER ONE Office 2016 Common Features: Taking the First Step 2
CASE STUDY SPOTTED BEGONIA ART GALLERY 2
GETTING STARTED WITH OFFICE APPLICATIONS 4

Starting an Office Application 4
Working with Files 5
Using Common Interface Components 8
Getting Help 15
Installing Add-ins 17

HANDS-ON EXERCISES 1 
Getting Started with Office Applications 19

FORMAT DOCUMENT CONTENT 24
Using Templates and Applying Themes 24
Modifying Text 26
Relocating Text 30
Checking Spelling and Grammar 32
Working with Pictures and Graphics 34

HANDS-ON EXERCISES 2 
 Format Document Content 37

MODIFY DOCUMENT LAYOUT AND PROPERTIES 42
Using Backstage View 42
Changing the Document View 44
Changing the Page Layout 45
Inserting a Header and Footer 48
Previewing and Printing a File 49

HANDS-ON EXERCISES 3 
Modify Document Layout and Properties 51

CHAPTER OBJECTIVES REVIEW 56
KEY TERMS MATCHING 58
MULTIPLE CHOICE 59
PRACTICE EXERCISES 60
MID-LEVEL EXERCISES 64
BEYOND THE CLASSROOM 66
CAPSTONE EXERCISE 67

Microsoft Office Access 2016 
■ CHAPTER ONE  Introduction to Access: Finding Your Way Through 

an Access Database 68
CASE STUDY MANAGING A BUSINESS IN THE GLOBAL 

ECONOMY 68
DATABASES ARE EVERYWHERE! 70

Opening, Saving, and Enabling Content in a Database 71
Recognizing Database Object Types 73
Modifying Data in Table Datasheet View 86
Adding Records to a Table 86
Deleting Records from a Table 88
Using Database Utilities 89

HANDS-ON EXERCISES 1 
Databases Are Everywhere! 93

FILTERS AND SORTS 101
Working with Filters 101
Performing Sorts 105

HANDS-ON EXERCISES 2 
Filters and Sorts 107

ACCESS DATABASE CREATION 113
Creating a Database 113

HANDS-ON EXERCISES 3 
Access Database Creation 120

CHAPTER OBJECTIVES REVIEW 124
KEY TERMS MATCHING 125
MULTIPLE CHOICE 126
PRACTICE EXERCISES 127
MID-LEVEL EXERCISES 133
BEYOND THE CLASSROOM 136
CAPSTONE EXERCISE 137

A01_GRAU9453_01_SE_FM.indd   7 2/23/16   7:49 AM



viii Contents

■ ChApter tWO  tables and Queries in relational Databases: 
Designing Databases and Extracting Data 138

CASe StUDy BAnK AUDIt 138
tABLe DeSIGn, CreAtIOn, AnD MODIFICAtIOn 140

Designing a table 140
Creating and Modifying tables and  
Working with Data 144

Hands-On ExErcisEs 1 
table Design, Creation, and Modification 150

MULtIpLe-tABLe DAtABASeS 155
Sharing Data 155
establishing table relationships 160

Hands-On ExErcisEs 2 
Multiple-table Databases 165

SInGLe-tABLe QUerIeS 173
Creating a Single-table Query 173
Using the Query Wizard 176
Specifying Query Criteria for Different Data types 179

Understanding Query Sort Order 181
running, Copying, and Modifying a Query 182

Hands-On ExErcisEs 3 
Single-table Queries 184

MULtItABLe QUerIeS 188
Creating a Multitable Query 188
Modifying a Multitable Query 190

Hands-On ExErcisEs 4 
Multitable Queries 194

ChApter OBjeCtIVeS reVIew 198
Key terMS MAtChInG 200
MULtIpLe ChOICe 201
prACtICe exerCISeS 202
MID-LeVeL exerCISeS 208
BeyOnD the CLASSrOOM 212
CApStOne exerCISe 213

■ ChApter three  Using Queries to Make Decisions: perform 
Calculations and Summarize Data Using Queries 216

CASe StUDy reAL eStAte InVeStOrS 216
CALCULAtIOnS AnD expreSSIOnS 218

Creating a Query with a Calculated Field 218
Formatting Calculated results 222
recovering from Common errors 223
Verifying Calculated results 225

Hands-On ExErcisEs 1 
Calculations and expressions 226

the expreSSIOn BUILDer AnD FUnCtIOnS 232
Creating expressions Using the expression Builder 232
Using Built-In Functions 234

Hands-On ExErcisEs 2 
the expression Builder and Functions 238

AGGreGAte FUnCtIOnS 243
Adding Aggregate Functions to Datasheets 243
Creating Queries with Aggregate Functions 244

Hands-On ExErcisEs 3 
Aggregate Functions 250

ChApter OBjeCtIVeS reVIew 254
Key terMS MAtChInG 255
MULtIpLe ChOICe 256
prACtICe exerCISeS 257
MID-LeVeL exerCISeS 260
BeyOnD the CLASSrOOM 264
CApStOne exerCISe 265

■ ChApter FOUr  Creating and Using professional Forms and reports: 
Moving Beyond tables and Queries 268

CASe StUDy COFFee ShOp StArtS new BUSIneSS 268
FOrM BASICS 270

Creating Forms Using Form tools 270
Modifying Forms 279
Working with a Form Layout 283
Sorting records in a Form 285

Hands-On ExErcisEs 1 
Form Basics 286

repOrt BASICS 295
Creating reports Using report tools 295
Using report Views 303

Modifying a report 304
Sorting records in a report 307

Hands-On ExErcisEs 2 
report Basics 309

ChApter OBjeCtIVeS reVIew 315
Key terMS MAtChInG 317
MULtIpLe ChOICe 318
prACtICe exerCISeS 319
MID-LeVeL exerCISeS 323
BeyOnD the CLASSrOOM 326
CApStOne exerCISe 327

A01_GRAU9453_01_SE_FM.indd   8 12/02/16   2:43 PM



 Contents ix

■ ChApter FIVe  Data Validation and Data Analysis: reducing  
errors and extracting Better Information 330

CASe StUDy IMpLeMentInG A new DAtABASe At 
TOMMY'S SHELTER	 330

DAtA VALIDAtIOn In tABLeS 332
establishing Data Validation 332
Controlling the Format of Data entry 337
Controlling Input with a Lookup Field 341

Hands-On ExErcisEs 1  
Data Validation in tables 345

DAtA AnALySIS USInG ADVAnCeD SeLeCt QUerIeS 352
Customizing Output Based on User Input 352
Using Advanced Functions 355

Hands-On ExErcisEs 2  
Data Analysis Using Advanced Select Queries 370

ChApter OBjeCtIVeS reVIew 376
Key terMS MAtChInG 377
MULtIpLe ChOICe 378
prACtICe exerCISeS 379
MID-LeVeL exerCISeS 383
BeyOnD the CLASSrOOM 386
CApStOne exerCISe 387

■ ChApter SIx 	Action	and	Specialized Queries: Moving Beyond  
the Select Query 390

CASe StUDy repLACeMent ChInA, InC. 390
ACtIOn QUerIeS 392

Determining When to Use an Action Query 392
Updating Data with an Update Query 393
Adding records to a table with an Append Query 397
Creating a table with a Make table Query 400
Deleting records with a Delete Query 401

Hands-On ExErcisEs 1  
Action Queries 404

SpeCIALIzeD QUerIeS 412
Summarizing Data with a Crosstab Query 412
Finding Duplicate records with a Query 419
Finding Unmatched records with a Query 422

Hands-On ExErcisEs 2  
Specialized Queries 427

ChApter OBjeCtIVeS reVIew 432
Key terMS MAtChInG 433
MULtIpLe ChOICe 434
prACtICe exerCISeS 435
MID-LeVeL exerCISeS 439
BeyOnD the CLASSrOOM 441
CApStOne exerCISe 442

■ ChApter SeVen 	Advanced	Forms	and Reports: Moving Beyond  
the Basics 444

CASe StUDy yeLLOwStOne COUnty  
teChnICAL SerVICeS 444

ADVAnCeD FOrMS 446
restricting edits in a Form 446
Understanding Combo Boxes 448
Setting the tab Order 451
Understanding Subforms 453

Hands-On ExErcisEs 1 
Advanced Forms 458

COntrOLS AnD SeCtIOnS 463
Understanding Advanced Controls 463
Understanding Sections 470

Hands-On ExErcisEs 2  
Controls and Sections 479

ChApter OBjeCtIVeS reVIew 484
Key terMS MAtChInG 485
MULtIpLe ChOICe 486
prACtICe exerCISeS 487
MID-LeVeL exerCISeS 491
BeyOnD the CLASSrOOM 494
CApStOne exerCISe 495

A01_GRAU9453_01_SE_FM.indd   9 12/02/16   2:43 PM



x Contents

■ ChApter nIne  Fine-tuning the Database: Analyzing  
and Improving Database performance 578

CASe StUDy the MetrOpOLItAn zOO 578
BUILt-In AnALySIS AnD DeSIGn tOOLS 580

Using the Database Documenter tool 581
Using the performance Analyzer tool 583
Using the table Analyzer tool 586
Using the Database Splitter tool 589

Hands-On ExErcisEs 1  
Built-In Analysis and Design tools 592

DAtABASe SeCUrIty 597
Controlling navigation 597
encrypting and password protecting a Database 600
Creating an executable Form of a Database 602

Hands-On ExErcisEs 2  
Database Security 605

DAtABASe nOrMALIzAtIOn 608
Understanding First normal Form 609
Understanding Second normal Form 611
Understanding third normal Form 613
Finalizing the Design 615

Hands-On ExErcisEs 3  
Database normalization 617

ChApter OBjeCtIVeS reVIew 621
Key terMS MAtChInG 622
MULtIpLe ChOICe 623
prACtICe exerCISeS 624
MID-LeVeL exerCISeS 627
BeyOnD the CLASSrOOM 630
CApStOne exerCISe 631

■ ChApter ten  Using Macros and SQL in Access:  
Advanced techniques 632

CASe StUDy retIreMent pLAn COntrIBUtIOnS 632
MACrO DeSIGn 634

Understanding the purpose of a Macro 634
Creating a Stand-Alone Macro 635
Using the Macro Designer to edit a Macro 637
Attaching an embedded Macro to an event 637

Hands-On ExErcisEs 1  
Macro Design 642

DAtA MACrOS 649
Identifying When to Use a Data Macro 649
Creating an event-Driven Data Macro 649
Creating a named Data Macro 650

Hands-On ExErcisEs 2  
Data Macros 653

StrUCtUreD QUery LAnGUAGe 660
Understanding the Fundamentals of SQL 660
Interpreting an SQL SeLeCt Statement 661
Using an SQL SeLeCt Statement as a record Source 663

Hands-On ExErcisEs 3  
Structured Query Language 667

ChApter OBjeCtIVeS reVIew 671
Key terMS MAtChInG 673
MULtIpLe ChOICe 674
prACtICe exerCISeS 675
MID-LeVeL exerCISeS 680
BeyOnD the CLASSrOOM 683
CApStOne exerCISe 684

■ ChApter eIGht  Get Connected: exchanging Data Between  
Access and Other Applications 496

CASe StUDy prOperty MAnAGeMent DAtA  
exChAnGe 496

COnneCt ACCeSS tO externAL FILeS 498
Creating a hyperlink Field 498
Adding an Attachment Field 501
Adding Attachment Controls to Forms and reports 504

Hands-On ExErcisEs 1  
Connecting Access to external Files 508

expOrt DAtA tO OFFICe AnD Other AppLICAtIOnS 516
exporting Data to excel 516
exporting Data to Word 521
exporting Data to a pDF or xpS Document 525
exporting Objects to Another Access Database 527

Hands-On ExErcisEs 2  
exporting Data to Office and Other Applications 530

IMpOrt AnD LInK DAtA In ACCeSS DAtABASeS 539
Linking to an Access table 539
Linking to Versus Importing an excel Spreadsheet 542
Importing an excel Spreadsheet 546
Importing a text File 550

Hands-On ExErcisEs 3  
Importing and Linking Data in Access Databases 554

ChApter OBjeCtIVeS reVIew 564
Key terMS MAtChInG 565
MULtIpLe ChOICe 566
prACtICe exerCISeS 567
MID-LeVeL exerCISeS 572
BeyOnD the CLASSrOOM 575
CApStOne exerCISe 576

A01_GRAU9453_01_SE_FM.indd   10 12/02/16   2:43 PM



 Contents xi

Application Capstone exercises

Access Introductory Capstone exercise (Chs. 1–4) 685

Access Comprehensive Capstone exercise (Chs. 5–10) 689

MICrOSOFt OFFICe 2016 SpeCIALISt ACCeSS 691

GLOSSAry 697

InDex 703

A01_GRAU9453_01_SE_FM.indd   11 12/02/16   2:43 PM



xii Acknowledgments

The Exploring team would like to acknowledge and thank all the reviewers who helped us throughout the years by providing us with their 
invaluable comments, suggestions, and constructive criticism.

Acknowledgments

Adriana Lumpkin 
Midland College

Alan S. Abrahams 
Virginia Tech

Alexandre C. Probst 
Colorado Christian University

Ali Berrached 
University of  Houston–Downtown

Allen Alexander 
Delaware Technical & Community College

Andrea Marchese 
Maritime College, State University of  
New York

Andrew Blitz 
Broward College; Edison State College

Angel Norman 
University of  Tennessee, Knoxville

Angela Clark 
University of  South Alabama

Ann Rovetto 
Horry-Georgetown Technical College

Astrid Todd 
Guilford Technical Community College

Audrey Gillant 
Maritime College, State University of  
New York

Barbara Stover 
Marion Technical College

Barbara Tollinger 
Sinclair Community College

Ben Brahim Taha 
Auburn University

Beverly Amer 
Northern Arizona University

Beverly Fite 
Amarillo College

Biswadip Ghosh 
Metropolitan State University of  Denver

Bonita Volker 
Tidewater Community College

Bonnie Homan 
San Francisco State University

Brad West 
Sinclair Community College

Brian Powell 
West Virginia University

Carol Buser 
Owens Community College

Carol Roberts 
University of  Maine

Carolyn Barren 
Macomb Community College

Carolyn Borne 
Louisiana State University

Cathy Poyner 
Truman State University

Charles Hodgson 
Delgado Community College

Chen Zhang 
Bryant University

Cheri Higgins 
Illinois State University

Cheryl Brown 
Delgado Community College

Cheryl Hinds 
Norfolk State University

Cheryl Sypniewski 
Macomb Community College

Chris Robinson 
Northwest State Community College

Cindy Herbert 
Metropolitan Community College–Longview

Craig J. Peterson 
American InterContinental University

Dana Hooper 
University of  Alabama

Dana Johnson 
North Dakota State University

Daniela Marghitu 
Auburn University

David Noel 
University of  Central Oklahoma

David Pulis 
Maritime College, State University of  
New York

David Thornton 
Jacksonville State University

Dawn Medlin 
Appalachian State University

Debby Keen 
University of  Kentucky

Debra Chapman 
University of  South Alabama

Debra Hoffman 
Southeast Missouri State  
University

Derrick Huang 
Florida Atlantic University

Diana Baran 
Henry Ford Community College

Diane Cassidy 
The University of  North Carolina at 
Charlotte

Diane L. Smith 
Henry Ford Community College

Dick Hewer 
Ferris State College

Don Danner 
San Francisco State University

Don Hoggan 
Solano College

Don Riggs 
SUNY Schenectady County Community 
College

Doncho Petkov 
Eastern Connecticut State University

Donna Ehrhart 
State University of  New York at  
Brockport

Elaine Crable 
Xavier University

Elizabeth Duett 
Delgado Community College

Erhan Uskup 
Houston Community College–Northwest

Eric Martin 
University of  Tennessee

Erika Nadas 
Wilbur Wright College

Floyd Winters 
Manatee Community College

A01_GRAU9453_01_SE_FM.indd   12 12/02/16   2:43 PM



 Acknowledgments xiii

Frank Lucente 
Westmoreland County Community College

G. Jan Wilms 
Union University

Gail Cope 
Sinclair Community College

Gary DeLorenzo 
California University of  Pennsylvania

Gary Garrison 
Belmont University

Gary McFall 
Purdue University

George Cassidy 
Sussex County Community College

Gerald Braun 
Xavier University

Gerald Burgess 
Western New Mexico University

Gladys Swindler 
Fort Hays State University

Hector Frausto 
California State University  
Los Angeles

Heith Hennel 
Valencia Community College

Henry Rudzinski 
Central Connecticut State University

Irene Joos 
La Roche College

Iwona Rusin 
Baker College; Davenport University

J. Roberto Guzman 
San Diego Mesa College

Jacqueline D. Lawson 
Henry Ford Community College

Jakie Brown Jr. 
Stevenson University

James Brown 
Central Washington University

James Powers 
University of  Southern Indiana

Jane Stam 
Onondaga Community College

Janet Bringhurst 
Utah State University

Jean Welsh 
Lansing Community College

Jeanette Dix 
Ivy Tech Community College

Jennifer Day 
Sinclair Community College

Jill Canine 
Ivy Tech Community College

Jill Young 
Southeast Missouri State University

Jim Chaffee 
The University of  Iowa Tippie College of  
Business

Joanne Lazirko 
University of  Wisconsin–Milwaukee

Jodi Milliner 
Kansas State University

John Hollenbeck 
Blue Ridge Community College

John Seydel 
Arkansas State University

Judith A. Scheeren 
Westmoreland County Community College

Judith Brown 
The University of  Memphis

Juliana Cypert 
Tarrant County College

Kamaljeet Sanghera 
George Mason University

Karen Priestly 
Northern Virginia Community College

Karen Ravan 
Spartanburg Community College

Karen Tracey 
Central Connecticut State University

Kathleen Brenan 
Ashland University

Ken Busbee 
Houston Community College

Kent Foster 
Winthrop University

Kevin Anderson 
Solano Community College

Kim Wright 
The University of  Alabama

Kristen Hockman 
University of  Missouri–Columbia

Kristi Smith 
Allegany College of  Maryland

Laura Marcoulides 
Fullerton College

Laura McManamon 
University of  Dayton

Laurence Boxer 
Niagara University

Leanne Chun 
Leeward Community College

Lee McClain 
Western Washington University

Linda D. Collins 
Mesa Community College

Linda Johnsonius 
Murray State University

Linda Lau 
Longwood University

Linda Theus 
Jackson State Community College

Linda Williams 
Marion Technical College

Lisa Miller 
University of  Central Oklahoma

Lister Horn 
Pensacola Junior College

Lixin Tao 
Pace University

Loraine Miller 
Cayuga Community College

Lori Kielty 
Central Florida Community College

Lorna Wells 
Salt Lake Community College

Lorraine Sauchin 
Duquesne University

Lucy Parakhovnik 
California State University, Northridge

Lynn Keane 
University of  South Carolina

Lynn Mancini 
Delaware Technical Community College

Mackinzee Escamilla 
South Plains College

Marcia Welch 
Highline Community College

Margaret McManus 
Northwest Florida State College

Margaret Warrick 
Allan Hancock College

Marilyn Hibbert 
Salt Lake Community College

Mark Choman 
Luzerne County Community College

Maryann Clark 
University of  New Hampshire

Mary Beth Tarver 
Northwestern State University

Mary Duncan 
University of  Missouri–St. Louis

Melissa Nemeth 
Indiana University-Purdue University 
Indianapolis

Melody Alexander 
Ball State University

Michael Douglas 
University of  Arkansas at Little Rock

A01_GRAU9453_01_SE_FM.indd   13 12/02/16   2:43 PM



xiv Acknowledgments

Michael Dunklebarger 
Alamance Community College

Michael G. Skaff  
College of  the Sequoias

Michele Budnovitch 
Pennsylvania College of  Technology

Mike Jochen 
East Stroudsburg University

Mike Michaelson 
Palomar College

Mike Scroggins 
Missouri State University

Mimi Spain 
Southern Maine Community College

Muhammed Badamas 
Morgan State University

NaLisa Brown 
University of  the Ozarks

Nancy Grant 
Community College of  Allegheny County–
South Campus

Nanette Lareau 
University of  Arkansas Community 
College–Morrilton

Nikia Robinson 
Indian River State University

Pam Brune 
Chattanooga State Community College

Pam Uhlenkamp 
Iowa Central Community College

Patrick Smith 
Marshall Community and Technical College

Paul Addison 
Ivy Tech Community College

Paula Ruby 
Arkansas State University

Peggy Burrus 
Red Rocks Community College

Peter Ross 
SUNY Albany

Philip H. Nielson 
Salt Lake Community College

Philip Valvalides 
Guilford Technical Community College

Ralph Hooper 
University of  Alabama

Ranette Halverson 
Midwestern State University

Richard Blamer 
John Carroll University

Richard Cacace 
Pensacola Junior College

Richard Hewer 
Ferris State University

Richard Sellers 
Hill College

Rob Murray 
Ivy Tech Community College

Robert Banta 
Macomb Community College

Robert Dus̆ek 
Northern Virginia Community College

Robert G. Phipps Jr. 
West Virginia University

Robert Sindt 
Johnson County Community College

Robert Warren 
Delgado Community College

Rocky Belcher 
Sinclair Community College

Roger Pick 
University of  Missouri at Kansas City

Ronnie Creel 
Troy University

Rosalie Westerberg 
Clover Park Technical College

Ruth Neal 
Navarro College

Sandra Thomas 
Troy University

Sheila Gionfriddo 
Luzerne County Community College

Sherrie Geitgey 
Northwest State Community College

Sherry Lenhart 
Terra Community College

Sophia Wilberscheid 
Indian River State College

Sophie Lee 
California State University,  
Long Beach 

Stacy Johnson 
Iowa Central Community College

Stephanie Kramer 
Northwest State Community College

Stephen Z. Jourdan 
Auburn University at Montgomery

Steven Schwarz 
Raritan Valley Community College

Sue A. McCrory 
Missouri State University

Sumathy Chandrashekar 
Salisbury University

Susan Fuschetto 
Cerritos College

Susan Medlin 
UNC Charlotte

Susan N. Dozier 
Tidewater Community College

Suzan Spitzberg 
Oakton Community College

Suzanne M. Jeska 
County College of  Morris

Sven Aelterman 
Troy University

Sy Hirsch 
Sacred Heart University

Sylvia Brown 
Midland College

Tanya Patrick 
Clackamas Community College

Terri Holly 
Indian River State College

Terry Ray Rigsby 
Hill College

Thomas Rienzo 
Western Michigan University

Tina Johnson 
Midwestern State University

Tommy Lu 
Delaware Technical Community College

Troy S. Cash 
Northwest Arkansas Community College

Vicki Robertson 
Southwest Tennessee Community

Vickie Pickett 
Midland College

Weifeng Chen 
California University of  Pennsylvania

Wes Anthony 
Houston Community College

William Ayen 
University of  Colorado at Colorado Springs

Wilma Andrews 
Virginia Commonwealth University

Yvonne Galusha 
University of  Iowa

A01_GRAU9453_01_SE_FM.indd   14 12/02/16   2:43 PM



 Acknowledgments xv

Special thanks to our content development and technical team:

Barbara Stover

Julie Boyles

Lori Damanti

Elizabeth Lockley

Joyce Nielsen

Linda Pogue

Sean Portnoy

Steven Rubin

A01_GRAU9453_01_SE_FM.indd   15 12/02/16   2:43 PM



xvi Preface

The Exploring Series and You
Exploring is Pearson’s Office Application series that requires students like you to think “beyond the point 
and click.” In this edition, we have worked to restructure the Exploring experience around the way you, 
today’s modern student, actually use your resources.

The goal of  Exploring is, as it has always been, to go farther than teaching just the steps to accomplish 
a task—the series provides the theoretical foundation for you to understand when and why to apply a 
skill. As a result, you achieve a deeper understanding of  each application and can apply this critical 
thinking beyond Office and the classroom.

The How & Why of This Revision
Outcomes matter. Whether it’s getting a good grade in this course, learning how to use Excel so 
students can be successful in other courses, or learning a specific skill that will make learners successful 
in a future job, everyone has an outcome in mind. And outcomes matter. That is why we revised our 
chapter opener to focus on the outcomes students will achieve by working through each Exploring 
chapter. These are coupled with objectives and skills, providing a map students can follow to get 
everything they need from each chapter.

Critical Thinking and Collaboration are essential 21st century skills. Students want and need 
to be successful in their future careers—so we used motivating case studies to show relevance of  these 
skills to future careers and incorporated Soft Skills, Collaboration, and Analysis Cases with Critical 
Thinking steps in this edition to set students up for success in the future.

Students today read, prepare, and study differently than students used to. Students use 
textbooks like a tool—they want to easily identify what they need to know and learn it efficiently. We 
have added key features such as Tasks Lists (in purple), Step Icons, Hands-On Exercise Videos, and 
tracked everything via page numbers that allow efficient navigation, creating a map students can easily 
follow.

Students are exposed to technology. The new edition of  Exploring moves beyond the basics of  the 
software at a faster pace, without sacrificing coverage of  the fundamental skills that students need to 
know.

Students are diverse. Students can be any age, any gender, any race, with any level of  ability or 
learning style. With this in mind, we broadened our definition of  “student resources” to include physical 
Student Reference cards, Hands-On Exercise videos to provide a secondary lecture-like option of  review; 
and MyITLab, the most powerful and most ADA-compliant online homework and assessment tool 
around with a direct 1:1 content match with the Exploring Series. Exploring will be accessible to all 
students, regardless of  learning style.

Providing You with a Map to Success to Move 
Beyond the Point and Click
All of  these changes and additions will provide students an easy and efficient path to follow to be 
successful in this course, regardless of  where they start at the beginning of  this course. Our goal is to 
keep students engaged in both the hands-on and conceptual sides, helping achieve a higher level of  
understanding that will guarantee success in this course and in a future career.

In addition to the vision and experience of  the series creator, Robert T. Grauer, we have assembled a 
tremendously talented team of  Office Applications authors who have devoted themselves to teaching 
the ins and outs of  Microsoft Word, Excel, Access, and PowerPoint. Led in this edition by series editor 
Mary Anne Poatsy, the whole team is dedicated to the Exploring mission of  moving students beyond 
the point and click.

preface
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 Key Features xvii

The How/Why Approach helps students move beyond the point and click to a true understanding of 
how to apply Microsoft Office skills.

• White Pages/Yellow Pages clearly distinguish the theory (white pages) from the skills covered in 
the Hands-On Exercises (yellow pages) so students always know what they are supposed to be doing 
and why.

• Case Study presents a scenario for the chapter, creating a story that ties the Hands-On Exercises 
together.

• Hands-On Exercise Videos are tied to each Hands-On Exercise and walk students through the 
steps of  the exercise while weaving in conceptual information related to the Case Study and the 
objectives as a whole.

The Outcomes focus allows students and instructors to know the higher-level learning goals and how 
those are achieved through discreet objectives and skills.

• Outcomes presented at the beginning of  each chapter identify the learning goals for students and 
instructors.

• Enhanced Objective Mapping enables students to follow a directed path through each chapter, 
from the objectives list at the chapter opener through the exercises at the end of  the chapter.
• Objectives List: This provides a simple list of  key objectives covered in the chapter. This includes 

page numbers so students can skip between objectives where they feel they need the most help.
• Step Icons: These icons appear in the white pages and reference the step numbers in the Hands-

On Exercises, providing a correlation between the two so students can easily find conceptual help 
when they are working hands-on and need a refresher.

• Quick Concepts Check: A series of  questions that appear briefly at the end of  each white 
page section. These questions cover the most essential concepts in the white pages required for 
students to be successful in working the Hands-On Exercises. Page numbers are included for easy 
reference to help students locate the answers.

• Chapter Objectives Review: Appears toward the end of  the chapter and reviews all important 
concepts throughout the chapter. Newly designed in an easy-to-read bulleted format.

• MOS Certification Guide for instructors and students to direct anyone interested in prepping for 
the MOS exam to the specific locations to find all content required for the test.

End-of-Chapter Exercises offer instructors several options for assessment. Each chapter has 
approximately 11–12 exercises ranging from multiple choice questions to open-ended projects.

• Multiple Choice, Key Terms Matching, Practice Exercises, Mid-Level Exercises, Beyond 
the Classroom Exercises, and Capstone Exercises appear at the end of  all chapters.
• Enhanced Mid-Level Exercises include a Creative Case (for PowerPoint and Word), which 

allows students some flexibility and creativity, not being bound by a definitive solution, and an 
Analysis Case (for Excel and Access), which requires students to interpret the data they are 
using to answer an analytic question, as well as Discover Steps, which encourage students to 
use Help or to problem-solve to accomplish a task.

• Application Capstone exercises are included in the book to allow instructors to test students on 
the entire contents of  a single application.

Key Features

CREATivE 
CASE

Watch the Video 
for this Hands- 
On Exercise!

ANALYSiS 
CASE

GraderHOE1 Training
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xviii Resources

resources

Instructor Resources
The Instructor’s Resource Center, available at www.pearsonhighered.com, includes the 
 following:

• Instructor Manual provides one-stop-shop for instructors, including an overview of  all available 
resources, teaching tips, as well as student data and solution files for every exercise.

• Solution Files with Scorecards assist with grading the Hands-On Exercises and end-of-chapter 
exercises.

• Prepared Exams allow instructors to assess all skills covered in a chapter with a single project.

• Rubrics for Mid-Level Creative Cases and Beyond the Classroom Cases in Microsoft Word format 
enable instructors to customize the assignments for their classes.

• PowerPoint Presentations with notes for each chapter are included for out-of-class study or 
review.

• Multiple Choice, Key Term Matching, and Quick Concepts Check Answer Keys

• Test Bank provides objective-based questions for every chapter.

• Scripted Lectures offer an in-class lecture guide for instructors to mirror the Hands-On Exercises.

• Syllabus Templates
• Outcomes, Objectives, and Skills List
• Assignment Sheet
• File Guide

Student Resources

Student Data Files
Access your student data files needed to complete the exercises in this textbook at 
www.pearsonhighered.com/exploring.

Available in MyITLab
• Hands-On Exercise Videos allow students to review and study the concepts taught in the Hands-

On Exercises.
• Audio PowerPoints provide a lecture review of  the chapter content, and include narration.
• Multiple Choice quizzes enable you to test concepts you have learned by answering auto-graded 

questions.
• Book-specific 1:1 Simulations allow students to practice in the simulated Microsoft Office 2016 

environment using hi-fidelity, HTML5 simulations that directly match the content in the Hands-On 
Exercises.

• eText available in some MyITLab courses and includes links to videos, student data files, and other 
learning aids.

• Book-specific 1:1 Grader Projects allow students to complete end of  chapter Capstone Exercises 
live in Microsoft Office 2016 and receive immediate feedback on their performance through various 
reports.
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Microsoft®

Access 2016
Comprehensive

(ex•ploring)
1. Investigating in a systematic way: examining. 2. Searching into 
or ranging over for the purpose of  discovery. 

S E R I E S
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Common 
Features

You will apply skills common across the  Microsoft Office suite to create and format 
documents and edit content in Office 2016 applications.

Learning 
OutcOme

OBJectiVeS & SKiLLS: After you read this chapter, you will be able to:

Getting Started with Office Applications

Objective 1: StArt An Office ApplicAtiOn 4
Open a Microsoft Office Application, Change Your 
Microsoft Account

Objective 2: WOrk With fileS 5
Create a New File, Open a File, Save a File

Objective 3: USe cOMMOn interfAce cOMpOnentS 8
Use the Ribbon, Use a Shortcut Menu, Use Keyboard 
Shortcuts, Customize the Ribbon, Use the Quick 
Access Toolbar, Customize the Quick Access Toolbar

Objective 4: Get help 15
Use the Tell me what you want to do Box, Use 
Enhanced ScreenTips

OBJectiVe 5: inStaLL add-inS 17
Use an Add-in from the Store

Hands-On ExErcisE 1: 
Getting Started With Office Applications 19

format Document content 

Objective 6: USe teMplAteS AnD ApplY theMeS 24
Open a Template, Apply a Theme

Objective 7: MODifY text 26
Select Text, Edit Text, Use the Mini Toolbar, Use 
Format Painter

Objective 8: relOcAte text 30
Cut, Copy, and Paste Text; Use the Office Clipboard

Objective 9: check SpellinG AnD GrAMMAr 32
Check Spelling and Grammar

Objective 10: WOrk With pictUreS AnD GrAphicS 34
Insert Pictures and Graphics, Resize and Format 
Pictures and Graphics

Hands-On ExErcisE 2: 
format Document content 37

Modify Document layout and properties 

Objective 11: USe bAckStAGe vieW 42
Customize Application Options, Enter Document 
Properties

Objective 12: chAnGe the DOcUMent vieW 44
Change the Document View

Objective 13: chAnGe the pAGe lAYOUt 45
Change Margins, Change Page Orientation, Use the 
Page Setup Dialog Box

Objective 14: inSert A heADer AnD fOOter 48
Insert a Footer, Insert a Header

Objective 15: previeW AnD print A file 49
Preview a File, Print a File

Hands-On ExErcisE 3: 
Modify Document layout and properties 51

Office 2016 
Common Features

casE study |  Spotted begonia Art Gallery
You are an administrative assistant for Spotted Begonia, a local art gallery. The gallery does 
a lot of community outreach and tries to help local artists develop a network of clients 
and supporters. Local schools are invited to bring students to the gallery for enrichment 
 programs.

As the administrative assistant for Spotted Begonia, you are responsible for overseeing 
the production of documents, spreadsheets, newspaper articles, and presentations that will 
be used to increase public awareness of the gallery. Other clerical assistants who are familiar 
with Microsoft Office will prepare the promotional materials, and you will proofread, make 
necessary corrections, adjust page layouts, save and print documents, and identify appropri-
ate templates to simplify tasks. Your experience with Microsoft Office 2016 is limited, but 
you know that certain fundamental tasks that are common to Word, Excel, and PowerPoint 
will help you accomplish your oversight task. You are excited to get started with your work!

M01_GRAU9453_01_SE_CF01.indd   2 12/19/15   12:34 PM



  3	 Office	2016	Common Features	•	Common Features 2016 3

K
o

n
st

an
ti

n
 C

h
ag

in
/

Sh
u

tt
er

st
o

ck

C
H

A
P

T
E

R1taking the first Step

casE study | Spotted begonia Art Gallery

Starting files files to be Submitted

f01h1letter
f01h2flyer
blank document

f01h2flyer_lastfirst
f01h3letter_lastfirst

FIGURE 1.1 Spotted Begonia Art Gallery Memo and Flyer
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4 Chapter 1 • Office 2016 Common Features

As you become familiar with Microsoft Office, you will find that although each soft-
ware application produces a specific type of  output, all applications share common fea-
tures. Such commonality gives a similar feel to each software application so that learning 
and working with Office software products is easy.

In this section, you will learn how to open an application, log in with your Microsoft 
account, and open and save a file. You will also learn to identify features common to Office 
software applications, including interface components such as the Ribbon, Backstage view, 
and the Quick Access Toolbar. You will experience Live Preview. You will learn how to get 
help with an application. You will also learn how to search for and install Office add-ins.

Starting an Office Application
Microsoft Office applications are launched from the Start menu. Click the Start button, 
and then click the app tile for the application in which you want to work. If  the applica-
tion tile is not on the Start menu, you can open the program from All apps, or alterna-
tively, you can click in the search box on the task bar, type the name of  the program, and 
press Enter. The program will open automatically.

STEP 1

Getting Started with Office 
Applications
Organizations around the world rely heavily on Microsoft Office software to produce 
documents, spreadsheets, presentations, and databases. Microsoft Office is a produc-
tivity software suite including a set of  software applications, each one specializing in a 
particular type of  output. You can use Word to produce all sorts of  documents, includ-
ing memos, newsletters, forms, tables, and brochures. Excel makes it easy to organize 
records, financial transactions, and business information in the form of  worksheets. 
With PowerPoint, you can create dynamic presentations to inform and persuade audi-
ences. Access is a relational database software application that enables you to record and 
link data, query databases, and create forms and reports.

You will sometimes find that you need to use two or more Office applications to pro-
duce your intended output. You might, for example, find that an annual report docu-
ment you are preparing in Word for an art gallery should also include a chart of  recent 
sales stored in Excel. You can use Excel to prepare the summary and then incorporate 
the worksheet in the Word document. Similarly, you can integrate Word tables and Excel 
charts into a PowerPoint presentation. The choice of  which software applications to use 
really depends on what type of  output you are producing. Table 1.1 describes the major 
tasks of  the four primary applications in Microsoft Office.

TABLE 1.1 Microsoft Office Software
Office 2016 Product Application Characteristics

Word
Word processing software used with text to create, edit, and format 
documents such as letters, memos, reports, brochures, resumes, and 
flyers.

excel
Spreadsheet software used to store quantitative data and to perform 
accurate and rapid calculations with results ranging from simple budgets 
to financial and statistical analyses.

powerpoint
presentation graphics software used to create slide shows for 
presentation by a speaker, to be published as part of a website, or to 
run as a stand-alone application on a computer kiosk.

access

relational database software used to store data and convert it into 
information. Database software is used primarily for decision making by 
businesses that compile data from multiple records stored in tables to 
produce informative reports.
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	 Getting	Started	with	Office	Applications	•	Common Features 2016 5

Change Your Microsoft Account
Although you can log in to Windows as a local network user, you can also log in using 
a Microsoft account. When you have a Microsoft account, you can sign in to any 
Windows computer and you will be able to access the saved settings associated with 
your Microsoft account. That means the computer will have the same familiar look that 
you are used to seeing on other computers and devices. Your Microsoft account will 
automatically sign in to all of  the apps and services that use a Microsoft account as 
the authentication. You can also save your sign-in credentials for other websites that 
you frequently visit. If  you share your computer with another user, each user can have 
access to his own Microsoft account; you can easily switch between accounts so you 
can access your own files.

To switch between accounts in an application such as Word, complete the 
following steps:

1. Click the profile name at the top-right of  the application.
2. Select Switch account. Select an account from the list, if  the account has already been 

added to the computer, or add a new account.

Logging in with your Microsoft account also provides additional benefits such as 
being connected to all of  Microsoft’s resources on the Internet. These resources include 
a free Outlook email account and access to OneDrive cloud storage. Cloud storage is a 
technology used to store files and to work with programs that are stored in a central loca-
tion on the Internet. OneDrive is an app used to store, access, and share files and folders. 
It is accessible using an installed desktop app or as cloud storage using a Web address. For 
Office applications, OneDrive is the default location for saving files. Documents saved in 
OneDrive are accessible from any computer that has an Internet connection. As long as 
the document has been saved in OneDrive, the most recent version of  the document will 
be accessible when you log in from any computer connected to the Internet. Moreover, 
files and folders stored on the computer’s hard drive or saved on a portable storage device 
can be synced with those on the OneDrive account.

OneDrive enables you to collaborate with others. You can easily share your docu-
ments with others or edit a document on which you are collaborating. You can even 
work with others simultaneously on the same document.

Working with Files
When working with an Office application, you can begin by opening an existing file that 
has already been saved to a storage medium, or you can begin work on a new file. When 
you open an application within Office, you can select a template to use as you begin work-
ing on a new file.

Create a New File
After opening an Office application, such as Word, Excel, or PowerPoint, you will be pre-
sented with template choices. Click Blank document (workbook, presentation, etc.) to 
start a new blank file. Perhaps you are already working with a document in an Office 
application but want to create a new file.

To create a new Office file, complete the following steps:

1. Click the File tab and click New.
2. Click Blank.
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6 Chapter 1 •	Office	2016	Common Features

Open a File
You will often work with a file, save it, and then continue the project at a later time. 
To open an existing file, you can click a location such as This PC or OneDrive and navi-
gate to the folder or drive where your document is stored. Once you make your way to the 
file to be opened, double-click the file name to open the file (see Figure 1.2).

To open a file, complete the following steps:

1. Open the application.
2. Click Open Other Documents (Workbooks, etc.).
3. Click the location for your file (such as This PC or OneDrive).
4. Navigate to the folder or drive and double-click the file to open it.

StEp 2

Open dialog box

FIGURE 1.2 The Open Dialog Box

Office simplifies the task of  reopening the file by providing a Recent documents list 
with links to your most recently opened files. Previously saved files, such as the data files 
for this book, are available in the Recent documents list, shown in Figure 1.3. If  you just 
opened the application, the recent list displays at the left. If  you do not see your file listed, 
you can click the link to Open Other Documents (or Workbooks, Presentations, etc.)

To access the Recent documents list, complete the following steps:

1. Open the application.
2. Click any file listed in the Recent documents list to open that document.

The list constantly changes to reflect only the most recently opened files, so if  it has 
been quite some time since you worked with a particular file, you might have to browse 
for your file instead of  using the Recent documents list to open the file.
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	 Getting	Started	with	Office	Applications	•	Common Features 2016 7

tIp:  KEEpInG FIlES On thE RECEnt DOCUmEntS lISt
The Recent documents list displays a limited list of  only the most recently opened files. You might, 
however, want to keep a particular file in the list regardless of  how recently it was opened. In 
Figure 1.3, note that the Pin this item to the list icon  displays to the right of  each file. Click the icon 
to pin the file to the list. At that point, you will always have access to the file by clicking the File tab 
and selecting the file from the Recent documents list. The pushpin of  the “permanent” file will change 
direction so that it appears to be inserted, indicating that it is a pinned item. If  later you want to 
remove the file from the list, click the inserted pushpin, changing its direction and allowing the file to be 
bumped off the list when other, more recently opened, files take its place.

Pin this item to the list

Recent documents list

FIGURE 1.3 Recent Documents List

Save a File
Saving a file enables you to later open it for additional updates or reference. Files are saved 
to a storage medium such as a hard drive, CD, flash drive, or to the cloud on OneDrive.

The first time that you save a file, you should indicate where the file will be saved and 
assign a file name. Of  course, you will want to save the file in an appropriately named 
folder so that you can find it easily later. Thereafter, you can quickly save the file with the 
same settings, or you can change one or more of  those settings, perhaps saving the file to 
a different storage device as a backup copy. Figure 1.4 shows a typical Save As pane for 
Office that enables you to select a location before saving the file.

It is easy to save a previously saved file with its current name and file location; click 
the Save icon on Quick Access Toolbar. There are instances where you may want to 
rename the file or save it to a different location. For example, you might reuse an event 
flyer for another event and simply update some of  the details for the new event.
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8 Chapter 1 •	Office	2016	Common Features

To save a file with a different name and/or file location, complete the 
following steps:

1. Click the File tab.
2. Click Save As.
3. Select a location or click Browse to navigate to the desired file storage location.
4. Type the file name.
5. Click Save.

Save to OneDrive

Save to your computer

Browse to a desired location

FIGURE 1.4 Save As in Backstage View

As previously mentioned, signing in to your Microsoft account enables you to save 
files to OneDrive and access them from virtually anywhere. To save a file to your OneDrive 
account follow the same steps as saving a file to your hard drive but select OneDrive 
and then the desired storage location on your OneDrive. You must be connected to the 
Internet in order to complete this action.

Using Common Interface Components
When you open any Office application you will first notice the title bar and Ribbon. The 
title bar identifies the current file name and the application in which you are working. 
It also includes Ribbon display options and control buttons that enable you to mini-
mize, restore down, or close the application window (see Figure 1.5). The Quick Access 
Toolbar, on the left side of  the title bar, enables you to save the file, and undo or redo edit-
ing. Located just below the title bar is the Ribbon. The Ribbon is the command center of  
Office applications. It is the long bar located just beneath the title bar, containing tabs, 
groups, and commands.
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	 Getting	Started	with	Office	Applications	•	Common Features 2016 9

Office applications enable you to work with objects such as images, shapes, charts, 
and tables. When you include such objects in a project, they are considered separate 
components that you can manage independently. To work with an object, you must select 
it. When you select an object, the Ribbon is modified to include one or more contextual 
tabs that contain groups of  commands related to the selected object. Figure 1.7 shows 
a contextual tab related to a selected picture in a Word document. When you click away 
from the selected object, the contextual tab disappears.

Minimize, Restore Down,
Close

Ribbon Display OptionsTitle bar

Quick Access Toolbar Home tab

FIGURE 1.5 The Title Bar and Quick Access Toolbar

Use the Ribbon
The Ribbon is composed of  tabs. Each tab is designed to appear much like a tab on a file 
folder, with the active tab highlighted. The File tab is located at the far left of  the Ribbon. 
The File tab provides access to Backstage view which contains Save and Print, as well as 
additional functions. Other tabs on the Ribbon enable you to modify a file. The active tab 
in Figure 1.6 is the Home tab.

More

Collapse the Ribbon

Dialog Box Launcher

Home tab is active

Tell me what you
want to do box

FIGURE 1.6 The Ribbon

Picture selected

Contextual tab for
selected picture

FIGURE 1.7 A Contextual Tab
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